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Description 

Do you use different standards? Do you misplace drawings? Do you still open drawings one at a time? 
Do you print drawings one at a time? Do you manually update the index sheet on a drawing package 
when a drawing name changes? If you answered yes to any of those questions, this class is for you. The 
Project Navigator in AutoCAD Architecture is your ultimate document management tool. Project Navigator 
contains all of your project information, including level info, in an organized and accessible structure. You 
can create a template file to eliminate the chance for error and populate data throughout the project. In 
this class we will set up a design project using a template, organize sheets, and publish the entire set to 
PDF when complete. At the end of this class, you’ll be able to take your existing company title blocks and 
create a template to use on your projects, increasing your productivity and efficiency. 

 

Your AU Expert: 
 

Sridhar Subramani has more than 15 years of CAD experience, working as Principal QA Analyst, 
Product Owner and scrum master at Autodesk, Inc. A seasoned professional in software testing, he has 
also been actively involved in news groups of AutoCAD Mechanical software and AutoCAD Architecture 
software and resolved over 1200 issues reported by customers. Sridhar regularly conducts in-house 
training sessions on AutoCAD and AutoCAD Architecture. He has written several technical solutions that 
are published on the Autodesk support website. 

 

 

 

 

 

 

 

3. Learning Objectives 

 Learn how to set up a project in AutoCAD Architecture 
 Learn how to create project and construction documents 
 Learn how to set up project standards using company templates 
 Learn how to increase productivity by saving valuable project time in fixing endless standards 

mismatch 
 Learn how to publish an entire project. 
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1. Unique Benefits of using Project organization: 
 

The Drawing Management System, which is optional, has features that provide us some very compelling 
benefits.  First, AutoCAD Architecture has the ability to coordinate all View Titles References, and 
Callouts, which virtually eliminates manual and error-prone labor.  Second, we are given a method of 
describing the Building so that External References are automatically loaded and coordinated.  Third, a 
mechanism is in place to ensure that whenever a new Style is added or changed, it may be synchronized 
with Project or Company Standards. 

2. Learn how to set up a project in AutoCAD Architecture 

2.1 Create a new Project: 
 

 

 

 

 

 

 

 

1. Launch AutoCAD Architecture 2017 or MEP 2017 using the Imperial profile 
2. Click the Project Browser icon from the Quick Access Toolbar or use the command 

PROJECTBROWSER 

Figure 1 



 

 

 

3. Click New Project’ icon as shown in Figure 2 

 

 

 

 

 

 

 

4. Enter the details as shown in figure-3 
5. Select  “Create from template project” and load “Commercial Template Project (Imperial)\Commercial 

Template Project (Imperial).apj” 
6. Click OK 

 

 

 

 

Figure 2 
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2.2 Project Properties: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. In the project browser, Right click “AU project” and select “Project Properties” (Figure-4). 
2. In the project properties dialog box, select ‘Yes’ for ‘Use Relative xref Path’ and ‘No’ for Prefix 

filenames with Project Number 

 

 

3. In the project properties dialog box, under Templates, use your company templates for Model/View 
Templates and Sheet Templates 
 

 
 
Note: If you do not have any company templates at this time, you can stick to the defaults. 

4. Click Close to close the project properties dialog box 

 

 

 

 

Figure 4 



3. Learn how to create project and construction documents 

3.1 Project Navigator – Project Tab: 
 

  

 

1. Click the Project Navigator icon on the Quick Access Toolbar (Figure-5) or use the command 
PROJECTNAVIGATOR to launch the Project Navigator Browser 

 

 

 

 

 

 

 

2. Select the ‘Project’ Tab and click the ‘Edit levels’ icon (Figure-6) to add Levels 
  

 

 

 
 

3. Click the ‘Add Level’ icon and add 3 Levels with Floor to Floor height as 15 feet 
4. Name the Floors as per your project requirement 

Note: Select “Auto Adjust Elevation” if you prefer to let AutoCAD Architecture adjust the Floor Elevation 
automatically whenever the Floor to Floor height is modified 

5. Click OK 

 

 

Figure 5 
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3.2 Project Navigator – Construct Tab: 
 

3.2.1 Adding existing drawings as Constructs: 
 

  

 

 

1. Right-click Constructs>>New>>Select Category 
2. Create a Category and name it “Plans” 
3. Create another Category and name it Building Outline 
4. Open Windows Explorer and navigate to the Data folder. 
5. Drag “Second Floor.dwg” on to the Constructs in the Project navigator 

 

 

 

6. Select “Second Floor” in the “Add Construct” dialog box, then select “Open in drawing editor” to open 
second floor, and click OK. 

7. Repeat step-5 and step-6 to add “Ground floor” drawing to Project Navigator. 
2 new Constructs named “Second floor” and “Ground Floor” are added to the Project Navigator. 

Figure 8 

Figure 9 



  

 

 

Now, imagine that the Typical Core drawing is being created by a consultant, and they will continue to 
revise the drawing. I would like to have this file linked as an x-ref into my project, so that as it changes, I 
will be aware of it. Yet, I don't want it included in the project's normal folder structure. So, this time in 
Windows Explorer, I'll hold down the ALT key, select the Typical Core drawing, and drag-and-drop it into 
the Elements section. In the Add Element dialog box, there is no Level and Division section. I'll click OK. 
Now, notice the little arrow on the lower-left corner of the Element file. This arrow indicates that this is a 
link. 

8. Hold down the Alt Key and Drag and drop “Typical Core.dwg” drawing on to the Elements in the 
Project navigator. 

3.2.2 Creating Constructs from Objects in Existing Drawings 
 

1. Open third floor.dwg file from the C:\data folder 
2. Grip select all the drawing entities in the drawing>>Drag and drop them on to the Plan Category in 

the Project navigator Construct Tab 

Figure 10 



 
 
 
 
 

3. Rename the Construct as “Third Floor 
4. Enable “Third floor” under ‘Division”, and Open the drawing in “Drawing Editor and click OK 

 
 
 
 

5. Open Exterior.dwg from the data folder 
6. Right-click “Building outline” Category under Constructs and select “New Construct” 
7. Name the construct “Exterior” 
8. Select all 4 floors under Division and click OK 

Figure 11 
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Because these walls are the full height of the building, I'll have them span all Levels. As soon as I select 
two Levels, at the bottom of the dialog box a message appears, telling me that the Construct has been 
set to spanning. When xrefed into a file, it will be inserted at the lowest checked level, and objects in the 
Construct will be shared. 

3.2.3 Creating Constructs from Other Constructs: 
 

1. Right- click Second floor and select “Copy Construct to levels” 
2. In the Copy level dialog box Select “First Floor” and click OK 

 
 
 
 

3. In the Project Navigator Constructs tab, >>rename the newly copied construct as “First Floor” 
 

3.2.4 Creating Elements. 
 

In Project navigator, Elements are created the same way as Constructs.  They can be created as  
new files, or by dragging files from Windows Explorer. 

 

3.3 Project Navigator – Views Tab: 
 

At this point in our Project, we have completed our Constructs and Elements creation. We are now ready 
to create some View files using Project Navigator. 
Let’s set another project as the active project (Project-2), where all Constructs are created. 
 
1. Open the Project Browser from the Quick Access Toolbar 
2. In the Project Browser, click Browse, and select “Project-2.apj” from C:\Data\Project-2 folder. 
3. In the Project Browser-Project Location task dialog, select “Repath the project Now”  and click OK. 

3.3.1 Creating a Plan View 
 

Note: On the Views tab, right-click Views at the top., In the pop-up menu, under the New View DWG 
cascading menu, there are 3 options: General, Section/Elevation, and Detail. I've created these types as 
3 Categories on the Views tab. Under General, you can find Floor or Reflected Ceiling Plans, or Building 
Models. Under Sections/Elevations you can find Building Sections or Exterior and Interior Elevations. 

Figure 13 



Under Details, you can find Enlarged Plans or Section Details. Let's create the Second Floor 
Dimensioned Plan View file. 

 

 
 
 

 
1. On the Views tab, under General>> Plan, right-click the Dimensioned Category and Select New View 

DWG, General 
2. In the Add General View dialog box, in the Name area, enter 02- Dimensioned, and in the Description 

area, enter Second Level Floor Plan, and then click  OK 
3. Select  ‘Open in drawing editor’ 
4. Click  Next, and in the 2nd page Context, select the checkbox for Level Second, Phase 1>>Pick Next, 

on the 3rd page 
5. Clear the check boxes corresponding to theconstructs you don’t want to see in the Plan View 
6. Click Finish 

 

3.3.2 Creating Elevation Views 
 

We will use the model to generate the exterior elevation views of the building. 
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1. Open Building Model.dwg from the views Tab>>Model category 
2. To generate the building elevations, from the Tool Palettes>>Callouts palette, click the Exterior 

Elevation Mark A3 tool. This places an elevation symbol on all four sides of the building, and 
generates the four elevation views automatically. 

3. At the Specify first corner of elevation region prompt, pick a point above and to the left of the plan. At 
the Specify opposite corner of elevation region prompt>> pick a point below and to the right of the 
plan. 

4. Ensure that Generate Section/Elevation, and Place Titlemark are selected. Also, ensure that the 
Scale is set to 1/8"=1'-0". 

5. In the Place Callout dialog box, select the new view drawing. 
6. In the Add Section/Elevation View dialog box, on the 1st page, General, for the Name, enter "Building 

Elevations”. 
7. Expand the Category drop down, choose the folder Section-Elevations. Select I'll accept the default 

Drawing Template file and click Next. 
8. Select all four levels under Division Phase 1. 
9. Under Content, deselect all the Constructs that are not to be xrefed>> click Finish 
10. At the Specify insertion point for the 2D elevation result prompt, pick a point above the site boundary 

and pick a point to specify the spacing and direction of elevations prompt. 
 
On the Views tab, in the Section-Elevations category, under the Building Elevations file, there are four 
named model space views. 

 

3.3.3 Creating Section Views 
 
I will use the model to generate the section views of the building. 

1. Open Building Model.dwg 
2. To generate the building sections, from the Tool Palettes, Annotation Palette, click the Section Mark 

A3T tool.  
3. At the Specify first point of section line prompt, pick to the left of the indent in the plan. At the Specify 

next point of line prompt, pick past the building to the right in plan, press ENTER. 
4. At the Specify section extents prompt, drag up past the top of the plan, and pick. 
5. In the Place Callout dialog box, at the top in the New Model Space View Name area, rename it to 

"East-West Section”. 
6. Make sure that the boxes are checked for Generate Section/Elevation, and Place Titlemark. I'll set the 

plot Scale to 1/8"=1'-0". 
7. Click the New View Drawing button.  In the Add Section/Elevation View dialog box, enter "Building 

Sections for the name. Expand the Category drop down and select the folder Section-Elevations. 
Click Next. 

8. Select all four Levels under Division Phase 1.  
9. Deselect all the constructs not to be xrefed and click Finish  
10. At the Specify insertion point for the 2D section result prompt, pick a point above the site boundary. 
 
Similarly create a North-South Section view by selection “Existing drawing” option in the Callout dialog 
box while create a section view. 
 

3.3.4 Annotation view 
 

Without using Project Navigator, Annotation Tags for objects such as Walls, Doors, Windows or Spaces 
have to be placed in the Base or Model Files, because you are attaching Property Sets directly to these 
objects. 
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1. Open 01-Dimensioned.dwg from the Project Navigator>>View tab>>Floor Plan 
Category>>dimensioned. 

2. Pick the doortag command from the Ribbon Annotate Tab>>Scheduling Panel and insert door tags as 
shown in the above drawing. 

3. Select the door with doortag “01”, right-click and select “Open xref drawing” 
4. Launch Property Palette and select the Extended Data Tab 
5. In the 01-Shell.dwg file, select the door 
6. Under Property Sets>>Door Objects>>Change the Number 20 as shown in the figure 
7. Save and close the drawing 
8. In the 01-Dimensioned.dwg>>Reload the Xref when prompted 
9. Notice the doortag is updated to 20 from 01. 

 
Similarly, you can create other annotations like Room tags and Window tabs 
 

3.3.5 Schedule views 
 
Project Navigator will assist us in creating Schedules for our project. Let's create the Door Schedule. In 
Project Navigator on the Views tab, we will create a new View file. 
 

1. In Project Navigator on the Views tab, Under the Architectural Category, in the new sub-category 
named Schedules, Right-click and select General View 

2. In the Add General page, name the view as Door Schedules and click Next. 
3. On the Context page, chose the Levels Ground, First, and Second, and Division as Phases 1 
4. On the Content page, deselect all the Constructs like Building Outlines, Site, Slabs, Spaces, and 

Structural, then click OK 
5.  Double-click the Door Schedules file name to open it 

6. Pick the Door Schedule tool from the Ribbon Annotate Tab>>Scheduling Panel 
7. At the Select objects or Enter to schedule external drawing prompt, window select all of the xrefs, 

then press Enter. At the Upper left corner of table prompt, I'll pick to the right of the Plans. At the 
Lower right corner (or Enter) prompt, I may drag and pick anywhere. 

 
 

We need to create a Named Model Space View in this file, so that only the Schedule will appear when we 
drag and drop this file onto a Sheet file Layout tab. 
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1. In the Project Navigator, right-click the Door Schedules file. In the pop-up menu pick the New Model 
Space View option. 

2. In the Add Model Space View dialog box, in the Name area enter Door Schedule. Accept the Scale, 
and click the Define View Window button on the middle right. 

3. At the Specify first corner prompt, pick a point above and to the left of the Schedule. At the Specify 
opposite corner prompt>>pick a point below and to the right of the schedule. 

4. Click OK and save this file. The new Named Model Space View is listed under the Door Schedules 
file. 

3.4 Project Navigator – Sheets Tab: 
 

3.4.1 Managing Sheet Set Properties 
 

We're now ready to create Sheet files for our Project. In Project Navigator we've created the Levels, 
Constructs, Elements, and View files necessary for this. Let's review creating Sheet files. In the Views 
files we've created Named Model Space Views, which is "What we want to plot". The Sheets files will be 
"Where we plot from". Depending on the type of template we specified in the Project properties. 
 
11. In the Project Navigator, select the Sheets tab 
12. Right-click the top node and select properties 
13. Review the Sheet set properties under “Sheet Creation” to see the Sheet set template used. 
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3.4.2 Creating Sheet Subsets and Sheets 
 

 
 
 
 
 

When creating the Plot Sheet files on the Sheets tab of Project Navigator, we may want to organize them 
into subsets. 

 

1. In the Project navigator>>Sheets tab, right-click the Sheet Set name, and from the pop-up menu, click 
New >> Subset.  

2. In the Subset Properties dialog box, enter Site for the new Subset Name.  This Sub set is used to 
store the drawings. 

3. Accept the next 4 default settings and click OK. 

4. Create 2 more subsets under the “Elevations” Subset. (Exterior Elevations, and Interior Elevations.) 
 

3.4.3 Creating Sheets 
 

 
 
 
 

1. Right-click the Plans subset, then click New>>Sheet 
2. In the New Sheet dialog box, enter the number A-102 
3. For the Sheet title enter Second Level Floor Plan.  
4. Under the Elevations subset there are 2 additional Subsets named Exterior, and Interior Elevations. 

Right-click the Exterior Elevations subset, then click New >> Sheet. 
5. Number it A-301, name it Building Elevations, and then click OK. 
6. Under the Large Scale Views subset right-click and then click New>>Sheet. Number it A-501, and 

name it Stair Plans, then click OK. 
7. Repeat this, creating another New Sheet, numbering it A-502, and naming it Bathroom Plans. Select  

“Open in drawing editor” and click OK. 
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3.4.4 Callouts to Create Named Model Space Views and Linking to Sheets 
 

1. Opening the Sheet file A-501 Stair Plans 
2. I want to add an enlarged stair plan to this Layout. 
3. Open the View file 02-Dimensioned, and zoom in on the stairway on the lower left 
4. From the Tool Palettes>>Callouts palette, pick the Detail Boundary B tool. 
5. At the Specify one corner of detail box prompt, pick a point above and to the left of the stairway. At 

the Specify opposite corner of detail box prompt, pick a point below and to the right of the stair. The 
callout boundary is created.  

6. At the Specify first point of leader line on boundary prompt, pick a pont diagonally down from the 
lower right of the callout boundary.  At the Specify next point of leader line, end line< end line> 
prompt pick a point to the right, then press ENTER. 

7. In the Place Callout Dialog Box name the view "Detail of Second Level Floor Plan".  
8. Clear the Generate Section/Elevation and Place Titlemark check boxes. 
9. Make sure the Scale is 1/4"=1'-0". 
10. Click the Current Drawing button. 
11. At the Specify first corner for model space view prompt, pick a point above and to the left of the stair. 

At the Specify opposite corner for model space view prompt pick a point below and to the right of the 
stair. 
On the View tab for this file, we'll see the Named Model Space View listed that we just created.  

12. Typing the command Showmodelspaceviews, we'll see all of them in this file. 
13. Save the file. 
14. Re-open the A-501 Sheet file. From the View tab drag the callout View of the Second Level Stair into 

the Layout. I'll pick a placement point. 
15. Pick the Title Mark tool from Callout Tool Palette 
16. At the Specify location of symbol prompt pick a point below the viewport, then drag to the right and 

pick a second point 
17. Select the callout that we placed. Picking on a non-grip point drag it onto the Named Model Space 

View in the View file. The fields are updated 
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Re-opening the 02-Dimensioned View file, the callout tag's fields have updated also. Opening the A-
102 Sheet file, and adjusting the Viewport Title Mark, and boundary, this Sheet file is using the same 
View file as an xref. Therefore, the fields in the tag are the same. 
 

 
 
 

 

3.4.5 Inserting Sheet List 
 

An additional benefit in using Project Navigator, is that it will keep track of all of the different Sheet files 
you're creating and allow you to create a Sheet List. 

 

 
 
 
 
1. On the Sheets tab, General subset right-click, and from the pop-up menu, click New >> Sheet. 
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2. In the New Sheet dialog box, Number it C-1, and for the Sheet title, enter ‘Cover Sheet’ and select 
Open in drawing editor, and click OK 

3. In this file, Let’s create a list of all the other Sheet files that are in the Sheet set. 
4. C-1 drawing opens. Right-click the name of the Sheet Set, and from the pop-up menu click Insert 

Sheet List Table. 
5. On the Subsets and Sheets tab you can  include or exclude any of the Subsets or Sheets listed. Click 

OK at the Specify insertion point prompt. Pick a point to place it in the Layout. 
 

4. Learn how to increase productivity by saving valuable project time in fixing endless standards 
mismatch 

4.1 Enabling and configuring Project Standards: 
 

 
The Project Standards feature lets you establish, maintain and synchronize standards across all 
drawings in an AutoCAD Architecture project. Project standards include standard styles, display 
settings, and AutoCAD standards that are used across all project drawings. 
 

 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
1. Enter command PROJECTSTANDARDS or from the Ribbon, click Manage Tab>>Project Standards 

panel >> Configure 
2. In the “Configure AEC Project Standards” dialog box, on the ‘Synchronization’ tab, select the option 

named “Manual” 
3. In the Standards Styles Tab, click “Add drawing”. Browse and select “Project Standards.dwg” from 

the Data>>Standards Folder 
4. Click OK 
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4.2 Synchronizing Drawings and Projects 
 

1. Open the drawing 01 Core.dwg  
2. Select an interior wall. On the Ribbon, click Wall tab>>General panel>> Edit Style. 
3. In the Wall Style Properties dialog box, on the Materials tab, change the Material Definition to 

Standard for the two CMU Components and then click OK. 
4. The stipple hatch pattern for these components is no longer there. Press ESC. 
5. On the Ribbon, click Manage tab>> Project Standards panel>> Synchronize DWG, The Synchronize 

Drawing with Project Standards dialog box opens. 

Note: This dialog box is divided into two sections. At the top is a list of objects in the current drawing 
that do not match the project standards. At the bottom is a list of objects in the current drawing that 
are not present in the project standards. 
 

 
 
 

6. Scroll down to the bottom of the Object Types in the upper section. The wall style that we just 
changed the material of is listed. In the Action column select Update from Standard, then click OK.  
The stipple pattern has returned.  

7. Select an interior wall, and on the Ribbon, click Wall tab>> General panel>> Edit Style tool.  
Note how in the Wall Style Properties dialog box, on the Materials tab, for the CMU Components, the 
Material has been reset to match the project standards. 

8. Click Cancel, then press ESC. 

4.3 Style Manager dialog box: 
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1. On the Ribbon click Manage tab>>Style & Display panel>> Style Manager 
2. In the Style Manager dialog box at the top>> the left column are all of the current projects standards 

files. (Figure 27) 
3. You can change the Styles in one file, but not the others. Click Cancel.  
4. To Synchronize common settings and styles across these project standards drawings, click Manage 

tab>> Project Standards panel drop-down>> Synchronize Project Standards 
 

4.4 Generate Reports: 
 

When you synchronize a project or a project drawing, you can save a synchronization report in HTML or 
XML format. In the project setup you can define whether a synchronization report should be generated 
during the synchronizing process. Additionally, when a project or a drawing is audited, the styles and 
display settings in the project drawing are compared with those of the project standards, and any out-of-
synch standards will be reported. 
 

 
 
 
 
 
1. Click  Manage tab>> Project Standards panel drop-down>> Setup Report 
2. In the Save Setup Report dialog box accept the File name and then click Save. 
3. Again, from the Project Standards panel drop-down>>click the Audit Report tool, which opens the 

Auditing Project Standards message box, then the Save Audit Report dialog box. Accept the File 
name, then click Save. 

4. From the Project Standards panel drop-down, click the Audit Project Drawing tool>> In the Save Audit 
Report dialog box accept the File name, then click Save. 

5. From Windows Explorer open the <<filename>>.Setup_Report.html file to review the file. 
6. From Windows Explorer open the <<filename>>.Audit_Report.html file to review the file. 
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5. Publishing Project Drawings 
 

 
 
 

 
1. Open any project. E.g. Sample Project or continue using the above project 
2. Select the Sheet Tab in the Project Browser 
3. Right- click Project>> Publish>>Publish Dialog Box 
4. In the Publish dialog box click “Publish to” drop down and choose PDF format or DWF format 
5. Review the sheets that will be published 
6. Click “Sheet set publish options”. Ensure “Multi sheet” checkbox is checked 
7. Click Publish 
8. Select a location to save the output file 
9. Once publish is completed, review the log file for errors and final *.pdf or *.dwf file. 

Figure 29 


